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Shared and Distinct Functional Effects of Patient-Specific
Tbr1 Mutations on Cortical Development
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T-Box Brain Transcription Factor 1 (TBR1) plays essential roles in brain development, mediating neuronal migration, fate
specification, and axon tract formation. While heterozygous loss-of-function and missense TBRI mutations are associated
with neurodevelopmental conditions, the effects of these heterogeneous mutations on brain development have yet to be fully
explored. We characterized multiple mouse lines carrying Tbrl mutations differing by type and exonic location, including the
previously generated Tbrl exon 2-3 knock-out (KO) line, and we analyzed male and female mice at neonatal and adult stages.
The frameshift patient mutation A136PfsX80 (A136fs) caused reduced TBR1 protein in cortex similar to Tbrl KO, while the
missense patient mutation K228E caused significant TBR1 upregulation. Analysis of cortical layer formation found similar
defects between KO and A136fs homozygotes in their CUX1" and CTIP2" layer positions, while K228E homozygosity pro-
duced layering defects distinct from these mutants. Meanwhile, the examination of cortical apoptosis found extensive cell
death in KO homozygotes but limited cell death in A136fs or K228E homozygotes. Despite their discordant cortical pheno-
types, these Tbrl mutations produced several congruent phenotypes, including anterior commissure reduction in heterozy-
gotes, which was previously observed in humans with TBRI mutations. These results indicate that patient-specific Tbrl
mutant mice will be valuable translational models for pinpointing shared and distinct etiologies among patients with TBRI-
related developmental conditions.
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Mutations of the TBRI gene increase the likelihood of neurodevelopmental conditions such as intellectual disability and au-
tism. Therefore, the study of TBRI can offer insights into the biological mechanisms underlying these conditions, which affect
millions worldwide. To improve the modeling of TBRI-related conditions over current Tbrl knock-out mice, we created
mouse lines carrying Tbrl mutations identical to those found in human patients. Mice with one mutant Tbrl copy show
reduced amygdalar connections regardless of mutation type, suggesting a core biomarker for TBR1-related disorders. In mice
with two mutant Tbr1 copies, brain phenotypes diverge by mutation type, suggesting differences in Tbr1 gene functionality in
different patients. These mouse models will serve as valuable tools for understanding genotype-phenotype relationships
among patients with neurodevelopmental conditions. j
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TBR1 (T-Box Brain Transcription factor 1) was among the
first genes linked to ID and/or autism via de novo mutations
(Neale et al., 2012; O’Roak et al., 2012a,b, 2014). Over 100 var-
iants impacting TBRI have been reported in ClinVar, and TBRI
is highly intolerant to both loss-of-function and missense
mutations (Landrum et al., 2018; Karczewski et al., 2020).
Accordingly, no biallelic TBR1 mutations have been identi-
fied in humans, and Thr1~~ mice die perinatally (Bulfone et
al., 1998; Nambot et al., 2020). The spatiotemporal expres-
sion of TBRI in human brain places it at the center of an au-
tism-associated gene network specific to mid-fetal glutamatergic
cortical neurons (Willsey et al., 2013). During the equivalent pe-
riod in mouse cortex, TBRI1 directly regulates the transcription
of other high-confidence autism-associated genes (Notwell et al.,
2016). Tbrl is expressed in several early-born neuronal popula-
tions essential for proper mouse corticogenesis, and complete
genetic knock-out (KO) consequently impairs cortical lamina-
tion, cell survival, neuronal fate acquisition, and axon tract for-
mation (Hevner et al,, 2001; Bedogni et al, 2010; Han et al,
2011; McKenna et al., 2011).

Individuals with de novo TBRI mutations exhibit moderate-
to-severe DD/ID, speech delays, autism or autistic traits, and
aggression (McDermott et al., 2018; Nambot et al., 2020). Over
half of patients examined by MRI showed anterior commissure
(AC) reduction, hippocampal dysplasia, and/or cortical malfor-
mations (Vegas et al., 2018; Nambot et al., 2020). Likewise, heter-
ozygous Tbrl knock-out mice (Tbr1*"") modeling human TBRI
haploinsufficiency showed anterior commissure reduction, cog-
nitive impairment, and reduced social interaction (Huang et al,,
2014). Mouse models in which Tbrl was conditionally deleted
(Tbr1%°) from cortical deep-layer glutamatergic neurons also
showed reduced social interaction or increased aggression (Fazel
Darbandi et al., 2018, 2020). While both Tbr1*"~ and Tbr1<°
models showed congruent defects in dendritic spine density,
Tbr1°“® models may have limited clinical translatability because
of the delayed deletion of Tbr1 several days after its initial expres-
sion. Moreover, Tbrl deletion models do not capture the allelic
heterogeneity of human TBRI mutations, and in vitro studies
indicate that mutant TBR1 proteins differ in their stability, tran-
scriptional activity, localization, and cofactor binding (Deriziotis
et al,, 2014; den Hoed et al., 2018).

Mice harboring the K228E patient mutation in the T-box of
TBR1 were recently generated and characterized (Yook et al.,
2019). In contrast to Thrl deletion mutants, K228E mutants
showed elevated levels of TBR1 protein, and the mutant K228E
protein exhibited decreased DNA affinity and increased struc-
tural stability in vitro. Moreover, K228E mutants showed altered
anxiety-like and social behaviors, which were accompanied
by transcriptional dysregulation, displacement of parvalbu-
min (PV)-positive interneurons, and increased inhibitory
synaptic transmission in the cortex. However, the degree of
functionality of the mutant allele remains unclear, as do its
effects on other Tbrl-regulated processes such as axon tract
formation and cell survival.

Here, we independently generated TbrI mutant mice with the
K228E mutation, as well as mice with the early-truncating frame-
shift patient mutation A136P{sX80 (A136fs). We also character-
ized an in-frame Tbrl deletion line (p.E348_P353del or A6aa)
encompassing five reported human TBRI variants in the T-box.
With the Tbrl exon 2-3 knockout as a comparison (Bulfone et
al., 1998), we used molecular, histologic, and genetic approaches
to determine the impacts of these mutations on TbrI expression
and cortical development.
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Materials and Methods

Experimental design and statistical analysis. Mice of each sex were
used for all experiments. For molecular and histologic experiments, mice
were analyzed at postnatal day 0 (P0) or adulthood (9-39 weeks). For
weight and behavior assessments, mice were analyzed at P4, P7, P10, and
P14. Cohorts for each experiment were composed of littermate wild-
type (WT) and mutant mice from at least two independent litters. For
Western blot and quantitative PCR (qPCR) experiments, at least three
mice/genotype/line were analyzed. For histologic experiments, at least
two mice/genotype/line were analyzed. Data plotting and statistical
tests were performed using Prism 9 (GraphPad Software). Data are
represented as the mean *= SEM or as violin plots. Each dot repre-
sents one animal where applicable. Analyses between two groups
were performed using unpaired t tests. Analyses among three
groups were performed using one-way ANOVA with Tukey’s mul-
tiple-comparisons test or two-way ANOVA with Siddk’s multiple-
comparisons test. Analysis of postnatal weight and motor assess-
ment was performed using two-way repeated-measures ANOVA
with Sidak’s multiple-comparisons test. Analysis of cumulative inter-
neuron distribution was performed using Kolmogorov-Smirnov tests.
Significance was defined as p < 0.05.

Animals. All animal procedures were approved by Oregon Health &
Science University Institutional Animal Care and Use Committee.
Tbr1*° mice (Bulfone et al., 1998) were rederived from cryopreserved
sperm obtained from MMRRC (Mutant Mouse Resource & Research
Centers) at the University of California, Davis (catalog #030263-UCD)
and backcrossed to a C57BL/6 background for at least two generations
before data collection. ThrIAP%%8 (abbreviated to TbrI*3%), Thr1*?*E,
and Tbr1*** mice were generated on a C57BL/6N]J background and back-
crossed to C57BL/6N] for at least two generations before data collection.
Tbr1*© mice were PCR genotyped using primers amplifying genomic Tbrl
and the neomycin (neo) cassette. Thr1*"? % and ThrI™**F mice were geno-
typed using PCR amplification of the mutation-containing genomic region
followed by restriction enzyme digest of the PCR product (BtsCI for
A136fs, BtsIMutl for K228E, New England Biolabs). Thr1*%* mice were
PCR genotyped using primers amplifying genomic Tbrl (Extended Data
Fig. 1-2, primer sequences). Mice were group housed under a 12 h light/
dark cycle and given ad libitum access to food and water.

CRISPR generation of mouse lines. CRISPR synthetic guide RNA
(sgRNA) design to generate Thr1*"*%, Thr1*??%% and Tbr1%** founders
was performed using the CRISPOR tool (http://crispor.tefor.net/;
Concordet and Haeussler, 2018). The generation of mutant mice was
performed by the Oregon Health & Science University Transgenic
Mouse Models Core based on published methods (Aida et al., 2015).
C57BL/6N] zygotes were coinjected with Cas9 protein (50 ng/pl; New
England Biolabs) or Cas9 mRNA (1000 ng/pl; TriLink BioTechnologies),
sgRNA (30 ng/pl; Synthego), and single-stranded-oligodeoxynucleotide
(ssODN) donor (100 ng/pl; Integrated DNA Technologies) containing
the patient mutation. Embryos were transplanted into pseudopregnant
recipient female CD-1 mice, and founders from these litters were identi-
fied via Sanger sequencing (Extended Data Fig. 1-2, sgRNA, ssODN do-
nor, and Sanger primer sequences).

Western blotting. Cortex was dissected at PO or adulthood (10-
39 weeks), flash frozen, and stored at —80°C until all samples were col-
lected. Frozen tissue from one cortical hemisphere per mouse (~30mg
at PO, ~100mg at adulthood) was dounce homogenized in ice-cold
RIPA buffer (150 mm NaCl, 1% IGEPAL CA-630, 0.5% sodium deoxy-
cholate, 0.1% SDS, 50 mm Tris-HCI pH 8.0, 2 mm EDTA pH 8.0) con-
taining Protease Inhibitor Cocktail (Roche). Nuclei were lysed using a
probe sonicator (model XL-2000, Misonix) at setting 6 with 5-10 s ON/
20 s OFF intervals until the lysate was clear (two rounds for PO, four to
five rounds for adult). Lysates were further incubated on ice for 30 min
then centrifuged at 10,000 relative centrifugal force for 10 min at 4°C to
remove debris. Protein concentrations were determined using the Pierce
BCA Protein Assay Kit (Thermo Fisher Scientific). Alfa Aesar Laemmli
SDS sample buffer (Thermo Fisher Scientific) was added to lysates,
which were boiled at 95°C for 5min before SDS-PAGE. Total protein
(30 pg/sample) was resolved on 4-15% polyacrylamide gels (BIO-RAD)
and transferred to PVDF membranes. Membranes were incubated in
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Figure 1.  Generation of mouse lines carrying Tbr7 mutations. A, Schematic of Tbr7 gene structure (left) and predicted protein products (right) for Tbr7 mutant mouse lines used in
this study: published Tbr7*“ line replacing exons 2-3 with a neomycin cassette (Bulfone et al., 1998) and three CRISPR-generated lines carrying a frameshift mutation (A136PfsX80 or
A136fs), missense mutation (K228E), or in-frame deletion of 6 aa (E348_P353del or A6aa). See Extended Data Figure 1-1 for reported human mutations within the in-frame deletion
site of Tbr12% mice. For Tbr gene, blue boxes indicate T-box coding sequence, gray boxes indicate other coding sequence, and white boxes indicate untranslated regions. B,
Multiple sequence alignment of TBR1 mutation sites across vertebrate species. €, Pairwise alignment of predicted frameshift regions of human and mouse TBR1-A136PfsX80 proteins.
D, Multiple sequence alignment of K228 and E348_P353 sites across mouse T-box family proteins. E, Sanger sequencing of genomic or TOPO-cloned DNA showing CRISPR-generated
Tor1A7%5, Tbr1%2%%€ ‘and Tbr1°%% mutations. See Extended Data Figure 1-2 for CRISPR oligonucleotide and Sanger primer sequences. F, Dorsal view of brains from postnatal day 0
Tor1%5 Tor1®2% and Tbr12%* mutant mice and wild-type littermates. Arrowheads indicate underdeveloped olfactory bulbs in Tbr1*"6%A165 ang Tpr1228E%228E mice. Scale
bar, T mm.

block solution [5% milk in TBS with 0.1% Tween-20 (TBST)] for 1 hat  catalog #T2200, Sigma-Aldrich). The following secondary antibody and
room temperature (RT), incubated in primary antibodies in block solu-  dilution was used: donkey anti-rabbit IgG IRDye 800CW (1:10,000; cata-
tion overnight at 4°C, washed in TBST four times for 5min each, incu- log #926-32213, LI-COR). Western blot band intensities were measured
bated in secondary antibodies in block solution for 1 h at room  using “Analyze > Gels” in ImageJ2/FIJI software (Rueden et al., 2017).
temperature, washed in TBST four times for 5min each, and imaged Within each blot, each TBR1 band signal was normalized to its corre-
with an Odyssey CLx using Image Studio software (LI-COR). The fol-  sponding loading control signal, and then each normalized TBR1 signal
lowing primary antibodies and dilutions were used: rabbit anti-TBR1 ~ was adjusted to the average normalized TBRI1 signal across WT
(1:1000; catalog #ab31940, Abcam); rabbit anti-8-Tubulin IIT (1:1000; replicates.
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€, Western blots for TBR1 in adult cortical lysates from Tbr7*

and patient mutant lines (n =3 mice per genotype). D, Schematic of Tbr7 ¢DNA indicating locations of Tbr7 mutations (arrow-

heads or bracket) and qPCR primers. Mutations are color-coded as in B. Blue shading indicates T-hox coding region. See Extended Data Figure 1-2 for qPCR primer sequences. E, F, qPCR for
Tbr1 using two primer sets in PO Tbr7 mutant mouse line cortex (1 = 3-6 mice per genotype). Genotypes are color coded as in B. G, H, Sanger sequencing of Tbr7 (DNA from PO Tor1*™** mu-
tant cortex. Red arrows indicate the position of mutation. Brackets indicate peaks corresponding to WT (black) and mutant (magenta) allele in Tor7 A" (DNA. Data are plotted as the mean
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*¥¥p < 0.001; ****p < 0.0001. ns, Not significant.

Reverse transcription qPCR. Cortex was dissected at PO, flash frozen,
and stored at —80°C until all samples were collected. Frozen tissue from
one cortical hemisphere (~30 g) was lysed in 1 ml TRIzol Reagent
(Thermo Fisher Scientific) and homogenized by passing through a 25 ga
needle. Total RNA was extracted using the RNeasy Lipid Tissue Mini Kit
(catalog #74804, QIAGEN) with on-column DNase digestion with
RNase-Free DNase Set (catalog #79254, QIAGEN) according to the
manufacturer protocols. cDNA was synthesized from 1pg of total
RNA using the ProtoScript II First Strand cDNA Synthesis Kit (cata-
log #E6560S, New England Biolabs) with oligo-dT priming according
to the manufacturer protocol. cDNA templates and no RT controls
were diluted 1:20 for multiplexed PrimeTime qPCR Assays using
Tbrl and Actb primers with FAM- and SUN-labeled probes, respec-
tively (Integrated DNA Technologies). qPCR assays were run in
duplicate or triplicate. Probe fluorescence was measured with a CFX
Connect Real-Time PCR Detection System using CFX Manager
Software (BIO-RAD) running the following cycling program: 95°C
for 3 min, 40 cycles of 95°C for 15 s and 60°C for 1 min, and 4°C hold.
qPCR primer efficiencies were measured using WT cortex cDNA for
the standard curve (undiluted to 1:10,000) and fell within 90-110%.
Ct values were obtained using the “single threshold” Cq
Determination Mode in CFX Manager Software (BIO-RAD). After
averaging across technical replicates for each sample, TbrI fold gene
expression was calculated using the 27" method with Actb as the

reference gene and adjustment to the WT average within the respec-
tive experimental batch of each sample. For Sanger sequencing of
Thr1*1%% cortex cDNA, 1l of cDNA was used as the PCR template for
M13 sequence-containing primers spanning exons 1 and 2, and purified
PCR product was Sanger sequenced using M13-forward primer. Sanger
sequencing traces were visualized using Sequencher software (Gene
Codes Corporation; Extended Data Fig. 1-2, primer sequences).
Immunohistochemistry. For PO samples, whole brains were drop
fixed in 4% electron microscopy (EM)-grade paraformaldehyde (PFA)
overnight at 4°C, then washed in PBS. For adult samples (9-19 weeks),
brains were fixed via transcardial perfusion with 10 ml of PBS and 10 ml
of 4% PFA, followed by postfix in 4% PFA for 1 h at 4°C, followed by
PBS wash. For cortical layering, interneuron, axon, and apoptosis
marker immunohistochemistry (IHC), brains were embedded in 3%
low-melting point (LMP) agarose and sectioned coronally or horizon-
tally at 100 um using a vibratome (model VT1200 S, Leica). Free-floating
sections anterior to the hippocampus were incubated in primary anti-
bodies in block solution (2% normal donkey serum, 0.2% Triton X-100
in PBS) for 48-72 h at 4°C, washed in PBS for >5 h, incubated in sec-
ondary antibodies and Hoechst stain 1:5000 in block solution overnight
at 4°C, washed in PBS for >5 h, mounted onto glass slides, and cover-
slipped with Fluoromount-G (Southern Biotech). For TBR1/NeuN IHC
in Tbri*??%E cortex, fixed brains were cryoprotected in 30% sucrose
overnight at 4°C, washed in PBS, embedded in O.C.T. (optimal cutting
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temperature) Compound (Tissue-Tek), and sectioned coronally at
20 pm using a cryostat (model TN50, Tanner). Free-floating cryosections
were incubated in primary antibodies in block solution overnight at 4°C,
washed in PBS three times for 10 min each, incubated in secondary anti-
bodies and Hoechst stain 1:5000 in block solution for 1 h at room tem-
perature, washed in PBS three times for 10 min each, mounted onto
glass slides, and coverslipped with Fluoromount-G (Southern
Biotech). The following primary antibodies and dilutions were
used: rabbit anti-cleaved caspase-3 (CC3; 1:500; model 9661, Cell
Signaling Technology); rat anti-CTIP2 (1:500; catalog #ab18465,
Abcam); rabbit anti-CDP/CUX1 (1:500; catalog #sc-13 024, Santa Cruz
Biotechnology); rat anti-L1 (1:500; catalog #MAB5272, Millipore); mouse
anti-NeuN (1:500; catalog #ab104224, Abcam); mouse anti-neurofilament/
neurofilament M (NF-M; 1:500; catalog #2H3, Developmental Studies
Hybridoma Bank); goat anti-parvalbumin (1:2000; catalog #PVG-213,
Swant); rabbit anti-somatostatin (SST; 1:500; catalog #T-4103.0050,
Peninsula Laboratories); and rabbit anti-TBR1 (1:500; catalog #AB10554,
Millipore). The following secondary antibodies and dilutions were used:
donkey anti-mouse IgG (H + L) Alexa Fluor 488 (1:500; catalog #A-21202,
Thermo Fisher Scientific); donkey anti-rabbit IgG (H + L) Alexa Fluor
546 (1:500; catalog #A10040, Thermo Fisher Scientific); donkey anti-goat
IgG (H+ L) Alexa Fluor 647 (1:500; catalog #A-21447, Thermo Fisher
Scientific); and donkey anti-rat IgG (H + L) Alexa Fluor 647 (1:500; catalog
#712-605-153, Jackson ImmunoResearch).

Neonatal weight and motor assessments. Weight measurements and
negative geotaxis testing were performed at P4, P7, P10, and P14 as pre-
viously described (Hill et al., 2008). For negative geotaxis, each pup was
placed with its head pointing downward on a 45° incline, and the latency
for the pup to face upward on the incline was recorded. If the pup failed
to turn within 60 s, or if the pup fell down the incline three times, the la-
tency was recorded as 60 s.

Dil labeling. PO whole brains were drop-fixed in 4% EM-grade PFA
for at least 24 h at 4°C, then washed in PBS. For corticothalamic labeling,
Dil crystals (catalog #D3911, Thermo Fisher Scientific) were embedded
in primary somatosensory (S1) cortex along the anteroposterior axis. For
thalamocortical labeling, Dil crystals were embedded in thalamus after
removal of hindbrain. Labeled brains were incubated in 4% PFA at 37°C
until labeling was visible in the target brain regions or axon tracts
(~9d). Brains were embedded in 3% LMP agarose and sectioned coro-
nally at 150 pm using a vibratome (model VT1200 S, Leica). Sections
were stained with Hoechst 1:5000 in PBS for 10 min, mounted onto glass
slides, and coverslipped with Fluoromount-G (Southern Biotech).

Fluorescence image acquisition. Images were acquired using ZEN
Blue software (Zeiss). IHC sections were imaged on an upright micro-
scope (model Axio Imager M2, Zeiss) equipped with an ApoTome2. For
cortical layering, interneuron, and apoptosis IHC, z-stacks were obtained
through the tissue section using the optimal interval for each objective.
For axon THC, images were obtained using Tile Scan mode and stitched
using ZEN. Dil-labeled sections were imaged on a dissecting microscope
(model Axio Zoom.V16, Zeiss).

Cortical layering analysis. Cortical layering analyses were performed
on z-projection images of coronal sections using ImageJ2/FIJI software.
Equivalent background subtraction and brightness/contrast adjustments
were applied to all images within an experiment. Images were rotated
until layers in S1 were approximately horizontal, then a 1024 x 1800
pixel rectangle was drawn over S1 and rescaled to encompass layer 1
through subplate. Pixel intensities were averaged horizontally within the
rectangular selection using “Analyze > Plot Profile,” and then these val-
ues were averaged into 100 equal bins from layer 1 through subplate
(percentage of cortical distance). Binned values for each sample were
minimum-maximum normalized using the minimum and maximum
average bin values across WT replicates. For the binning of “percentage
of cortical distance” into layers for CTIP2 fluorescence comparisons, the
following bins were determined based on Hoechst fluorescence: L6, 0—
35%; L5, 36-55%; L2-4, 56-100%.

Interneuron distribution analysis. Interneuron distribution analyses
were performed on z-projection images of coronal sections using
Image]2/FIJI software. Equivalent background subtraction and binary
thresholds were applied to all images within an experiment. Images were
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rotated until layers in S1 were approximately horizontal, then a rectan-
gular region of interest (ROI) measuring a width of 1024 pixels x height
measure in pixels of layer 1 through subplate was drawn over S1. Within
this ROI, interneuron counts and x-y coordinates were obtained using
“Measure > Analyze Particles” with equivalent particle size parameters
for all images. These values were then used to determine the number of
cells per RO, the fraction of cells per bin (10 bins or 2 bins), and the cu-
mulative density of cells along the ROI.

Apoptosis analysis. Apoptosis analyses were performed on z-projec-
tion images of coronal sections using ImageJ2/FIJI software. Cells within
one cortical hemisphere of one section per animal were manually
counted using “Plugins > Analyze > Cell Counter.” Cortical area was
calculated using the Polygon tool to manually select the ROI.

Results

Generation of Tbrl mutant mouse lines

Using CRISPR/Cas9 genome editing (Aida et al., 2015), we gen-
erated the following three Thrl mouse lines: Thr1*"*** (c.402del;
p.A136PfsX80), Thr1*?*F (c.682A>G; p.K228E), and Thr1*%*
(c.1042_1059del; p.E348_P353del; Fig. 1A). The sequence changes
producing these predicted mutant proteins are identical between
human and mouse. A136PfsX80 is an autism-associated frameshift
mutation predicted to yield a truncated protein missing the T-box
DNA-binding domain, while K228E is an autism-associated mis-
sense mutation within the T-box (O’Roak et al,, 2012a,b). Both
mutations impact highly conserved residues among vertebrates,
and the residues following the frameshift of A136fs are conserved
between human and mouse (Fig. 1B,C). The in-frame deletion
mutant p.E348_P353del (A6aa) was generated through chance
nonhomologous end joining during CRISPR editing intended to
generate a different point mutation. This deletion is also located
within the T-box and encompasses the following five reported
human TBRI variants in ClinVar and gnomAD: two nonsense
mutations classified as pathogenic or likely pathogenic (S351X,
Q352X); and three missense mutations of uncertain or conflicting
significance (T350A, S351R, P353A; Extended Data Fig. 1-1;
Landrum et al., 2018; Karczewski et al., 2020). Despite strong spe-
cies conservation of residues 348-353, these residues fall within a
poorly conserved site among mouse T-box family proteins (Fig.
1B,D).

For each line, we tested multiple CRISPR sgRNA sequences,
and for Tbr1*% and Tbr1*??*" we designed single-stranded
oligo DNA donors to knock in the mutations through homol-
ogy-directed repair (Extended Data Fig. 1-2). Using Sanger
sequencing, we confirmed the Tbrl patient mutations and lack
of local (~300bp) off-target edits in the founder mice (F0) and
their offspring (Fig. 1E). While the sgRNAs had limited potential
for exonic off-target effects (two or fewer off-target mismatches),
we further accounted for any off-target edits by backcrossing
each line to the parental C57BL/6NJ strain for at least two genera-
tions and always comparing littermate controls and mutants within
experiments. For Tbr1**%, we also characterized three separate
F1-descendant branches and identified no brain phenotypic differ-
ences among these lineages, further suggesting that any phenotypes
observed were specific to the primary Tbr1 editing event.

Heterozygous mutants from the Tbr1*"*%, Tbr1"***F, and
Tbr1*°* lines, as well as Tbr1“*** homozygotes, appeared healthy
with normal outward morphology. In contrast, Thr14!3%/A136%
and Thr1"**%#%22%F mice died perinatally and had small olfactory
bulbs (Fig. 1F). Underdevelopment of the olfactory bulbs was pre-
viously described in homozygous mutants from the Tbrl knock-
out (Tbr1®®) line, which was generated by replacement of exons
2-3 with a PGK-neomycin cassette (Fig. 14; Bulfone et al., 1998).
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Homozygous K228E mutation causes ectopic TBR1 localization in cortex. A, TBRT immunostaining in PO 7br7 mutant mouse line S1 cortex. B, Quantification of TBRT fluorescence

intensity across the cortical mantle from A (n = 2—4 mice/genotype). €, D, TBRT immunostaining and quantification in adult 7br7*° and patient mutant line S1 cortex. E, Coimmunostaining for
TBR1 and NeuN in PO Tor7 /" and Tbr1™#57%2%5 51 cortex. SP, Subplate. Scale bars: A, E, 200 um; €, 500 zm. Data are plotted as the mean = SEM.

We proceeded to characterize Tbrl expression in the Thri*13%,

Tbr1*??% and Tbr12%* lines in comparison with the Tbrl KO ine.

Contrasting effects of Tbr1 mutations on TBR1 protein
levels in cortex

We first measured TBR1 protein levels in PO cortex from Thr1<©
mice (heterozygotes denoted as Tbrl*/~, homozygotes denoted
as Tbr1”") and the CRISPR-generated mutant mouse lines. Full-
length TBR1 signal was reduced by ~25% in both Tbr1*/
and Tbr1*/413F and completely absent in both Tbrl™~
and Tbr1APFABE (Tpr1X0: F, 1o = 60.2, p<0.001; Thr145%:
F(215)=33.0, p<0.001; ANOVA; Fig. 2A,B). The predicted trun-
cated TBR1-A136PfsX80 protein was also undetectable using an N-
terminal TBR1 antibody. In contrast, TBR1 levels were increased by
twofold and fivefold in Tbr1™ % and Tbr1"**** %% cortices,
respectively, while TBR1 was unchanged in Tbr1*** mutants
(Tbr1*?%E; Fy6)=55.0, p=0.001; Tbr1“®: F,g =0.414, p=0.674;
ANOVA). These TBR1 alterations were maintained in adult hetero-
zygous mutant cortex (Tbr1%%, p=0.007; Tbr1***, p=0.016;
Tbr1*??E, p=0.012; ¢ test; Fig. 2C). Despite decreases in TBR1 pro-
tein in Tbr1*© and Thr1**** mutants, qPCR analysis using primers

downstream of these mutations revealed that Tbr! transcript levels
were not decreased in heterozygotes, and were modestly decreased
in homozygotes, suggesting that the protein reductions resulted
from post-transcriptional processes (Tbr1*<®: Fo15=184, p<
0.001; Tbr1*"*%*. F, 5 =445 p=0030; ANOVA; Fig. 2D,E).
To validate this finding and compare transcript degradation at the
5" end versus the 3" end of mutant transcripts, we repeated qPCR
with primers targeting the 5" end of Tbrl and obtained similar
results as the 3’ qPCR (Tbr1%©: Fo15=11.4, p=0.001; Thr1A13%,
F15=10.1, p=0.002; ANOVA; Fig. 2D,F). However, when we
performed Sanger sequencing of cDNA from Tbrl ™A% cortex,
transcripts from the mutant allele comprised only a small propor-
tion of the overall Tbr1 transcript, suggesting upregulation from the
WT allele and/or degradation of mutant transcripts via nonsense-
mediated decay or other mRNA surveillance mechanisms (Fig. 2G,
H). In Tbr1 ™% and Tbr1"*******%€ Thr1 was increased by 1.5-
fold and 3.5-fold, respectively, indicating that their increased
TBR1 protein levels are attributable to transcriptional upregula-
tion (TbrI"**%%: F(, 6= 156.6, p < 0.001; ANOVA; Fig. 2E). TbrI
transcript levels were unchanged in Tbr1*°* mutants (Tbr1“%*:
Fis =131, p=0.337; ANOVA; Fig. 2E).
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In the developing cortex, TBRI1 is present at high levels in
deep-layer excitatory projection neurons, and in adulthood is
present in both upper-layer and deep-layer excitatory neurons
(Hevner et al., 2001). To assess TBR1 layer distribution and lev-
els, we immunostained for TBR1 in PO and adult brain sections
and plotted fluorescence profiles across the cortical layers. At
both neonatal and adult stages, heterozygotes of each mutant
line showed TBRI layer distributions similar to those of WT
(Fig. 3A-D). While Tbr1~ = and Thr143PA135 showed minimal
TBRI1 fluorescence at PO, Tbr1*****??%F ynexpectedly showed
substantial TBR1 upregulation across all cortical layers (Fig. 34,
B). In these mice, the vast majority of NeuN ™ cortical neurons
expressed TBR1 (Fig. 3E). In contrast to the other homozygous
mutants, Thr1“%*A%% showed normal deep-layer TBRI expres-
sion in PO cortex (Fig. 3A,B). Overall, these results show the fol-
lowing: (1) A136PfsX80 causes the absence of TBR1 protein; (2)
K228E causes elevated TBR1 levels because of transcriptional up-
regulation and, in homozygotes, ectopic protein expression; and
(3) the deletion of residues 348-353 has no impact on TBR1
levels.

Homozygosity of different Tbr1 mutations causes distinct
cortical layering phenotypes

During corticogenesis, newborn neurons migrate outward from
a germinal zone to form six cytoarchitectural layers, and neuro-
nal subpopulations within each layer obtain distinct transcrip-
tional and functional identities (Kwan et al., 2012). Thr1™~ mice
show reeler-like disorganization of cortical layering and mis-
specification of layer 6 (L6) neurons to L5-like neurons
(Hevner et al., 2001; Han et al., 2011; McKenna et al., 2011).
To examine cortical formation and neuronal identity in the
Tbrl mutant lines, we immunostained for layer markers CUX1
(L2-4) and CTIP2 (L5) and costained for nuclear marker
Hoechst at PO and adulthood. At both stages, all Tbr1 heterozy-
gotes and Thr1*%*“A%% homozygotes showed grossly normal
layer formation in primary somatosensory (S1) cortex (Fig.
4A-D). By adulthood, Tbr1™"~, Tbr1™/A13% and Tbr1*/%22%F
heterozygotes showed reductions in CTIP2 fluorescence in-
tensity in L6, suggesting downregulation of this transcription
factor in mature heterozngous mutant cortex (Tbr1%°

11.1, p=0.005; Tbr1*"?%;

1 Fa,15) =
F19)=2.44, p=0.153; Thr K22,
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Fa,24)=4.84, p=0.038; ANOVA; Fig. 4C,E). Homozygous
Tbr1™~, TbrI*3FAK and Thr1*?28K228E mice showed
major cortical layering defects differing by mutation (Fig. 44,
B). Specifically, in Tbr1”~ and Tbr1*"3413¢F mice, layer
positions were inverted, with CUX1" cells mostly residing in
inner cortex and CTIP2 " cells almost exclusive to outer cor-
tex. In contrast, Thr1*??¥%228F mice showed a more complex
layering phenotype, with CUX1" cells forming a thin mid-
cortical layer and CTIP2" cells residing in both outer and
inner cortex. Tbr1™", ThrI*13F/A136K “and Thr1*228E/K228E
homozygotes also showed an overabundance of CTIP2" neu-
rons compared with WT, suggesting L6-to-L5 misspecifica-
tion. Overall, these data indicate that one WT copy of Tbrl is
sufficient for normal cortical layer formation. Furthermore,
KO, A136PfsX80, and K228E mutations have discordant
effects on cortical layer formation, but congruent effects on
deep-layer marker CTIP2 expression.

To further assess the functionality of the K228E and A6aa al-
leles, we performed genetic complementation tests by crossing
each of these mutant lines with the Tbr1%° line. Tbr1****¥~ cort-
ical layering was phenotypically intermediate between Thr1™~
and Thr1®*?8¥K228E with CUX1 and Hoechst distributions
resembling the former, and TBR1 and CTIP2 distributions

resembling the latter (Fig. 5A,B). In contrast, Tbr1***”~ mice

showed normal layer formation, despite having only one copy of
the mutant allele on a null background (Fig. 5C,D). These results
confirm that the T-box mutant K228E has insufficient function-
ality to mediate proper cortical layer formation, while amino
acids 348-353 of the T-box are dispensable for layer formation.
Thus, we limited further characterization of the Tbr1**** line to
focus on the more pathogenic patient-specific mutations.

Tbr1 mutant mice show normal growth and motor function

Patients with TBRI mutations have been reported to exhibit
microcephaly, growth delay, developmental motor delay, and
hypotonia (Palumbo et al, 2014; Nambot et al, 2020). We
assessed postnatal growth in Tbr1%°, Tbr1*"*%, and Tbr1****¢
mutant mice but found no changes in brain-to-body mass ratio
at PO (TbrI*®: F530)=2.16, p=0.133; Tbr1*"**: Fp, 14 =1.56,
p=0238; Tbr1"?**%: F,,4=0.665, p=0.522; ANOVA), or in
body mass from P4 to P14 (Tbr1*®: F ., =0.184, p=0.673;
TbrI*P%F: F( 40)=0.941, p=0.338; Tbr1****%; F,3)=0.00,895,
p=0.926; ANOVA; Fig. 6A,B). Furthermore, heterozygous
mutants did not show impairment in the negative geotaxis motor
test across postnatal development (Tbr1<°: Fy 14 =1.17, p=0.297;
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Figure 6.  Normal growth and motor development of postnatal Tbr7 mutant mice. 4, Brain mass, body mass, and brain/body mass ratio measurements for Tor1*® and patient mutant mouse

lines at PO (n = 5-18 mice/genotype). B, Body mass measurements for 7br7*’

and patient mutant mouse lines across postnatal development (n = 10-27 mice/genotype). C, Latency for mouse

pups to orient upward on a slope in tj\e negative geotaxis test of motor coordination (n = 8-26 mice/genotype). One-way ANOVA with Tukey’s multiple-comparisons test was used in A; two-
way repeated-measures ANOVA with Sidak’s multiple-comparisons test was used in B and C. ns, Not significant.

Tbr1*P%: Fy 30, =7.76e-005, p=0993; Tbr1****%: F ., =0305,
p=0.586; ANOVA; Fig. 6C). Thus, these Tbr] mutations have min-
imal impact on the growth and gross motor function of mice during
development.

Tbr1 mutant mice show normal interneuron distributions in

S1 cortex

While Tbrl expression in the cortex is restricted to glutamatergic
neurons, Thr1”~ mice show abnormal distribution of GABAergic
interneurons; furthermore, Thr1""****! mice show displacement
of PV-expressing interneurons, but not other interneuron sub-
types, in medial prefrontal cortex (Hevner et al., 2001; Yook et al.,
2019). To examine non-cell-autonomous effects of ThrI mutations
on cortical interneuron distribution, we immunostained for the
major interneuron subtype markers PV and SST in S1 cortex of

adult Tbr1™", Tbr1/A1% and Tbr1™*??E mice (Fig. 7A,B). For
each interneuron subtype, we found no changes in cell densi
(SST Tbr1*®, p=0.293; SST Tbr1*"**, p=0.318; SST Tbr1***,
p=0.897; PV TbrI*°, p=0.821; PV Tbr1*"**, p=0902; PV
Tbr1*??%E, p = 0.459; t test) or distribution (SST Tbr1*°, p=0.994;
SST Tbr1*P%, p>0.999; SST Tbr1*??*E p>0.999; PV Thr1<°,
p=0699 PV Tbri*P%*, p>0999 PV Tbr1"?*%, p>0.999;
Kolmogorov-Smirnov test; Fig. 7C-]). These results indicate lim-
ited impact of Thr]l mutations on interneuron distributions in S1
cortex.

Tbrl patient mutations A136fs and K228E cause equivalent
axon tract defects to Tbr1 KO

Tbrl is required for normal axon tract development in the brain:
Tbr1”~ mice show severe defects of the corpus callosum, internal
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Congruent axon tract defects across Tbr7 mutant mouse lines. A, Immunostaining for axon marker L1 (white) and Hoechst nuclear stain (blue) in PO coronal brain sections from

Tor1*° and patient mutant lines. Arrow indicates posterior limb of AC in wild-type mouse. Closed arrowhead indicates anterior limb of AC in wild-type and heterozygous mutant mice. Open
arrowheads indicate bundled and misdirected callosal axons in homozygous mutants. n = 3-4 mice examined per genotype. B, Immunostaining for L1 (green) and NF-M (magenta) with
Hoechst (blue) in PO horizontal brain sections from Tbr7*° and patient mutant lines. Arrow indicates posterior limb of AC in wild-type mouse. Arrowhead indicates anterior limb of AC in wild-
type and heterozygous mutant mice. n = 2 mice examined per genotype. €, Immunostaining for NF-M in adult coronal brain sections from Tbr7® and patient mutant lines. Inset (dotted lines)
shows higher magnification of posterior limb of AC. Arrowhead indicates thin AC posterior limb observed in one Tbr7*?* heterozygote. n=3-6 mice examined per genotype. D,
Immunostaining for L1 (white) and Hoechst (blue) in PO coronal brain sections from Tbr7 patient lines. Arrowheads indicate abnormal organization of internal capsule axons in homozygotes.

Scale bars: 4, B, 500 um; C, D, T mm.

capsule, and AC, and Tbr1™/~ mice lack the posterior limb of the
AC (Hevner et al., 2001; Huang et al.,, 2014). To examine axon
tract formation in the Tbrl patient mutant lines, we immuno-
stained for axon markers L1 and NF-M at P0 and adulthood. At
these stages, nearly all heterozygotes examined from each Tbrl
line lacked the posterior limb of the AC, indicating a congruent
and highly penetrant phenotype of heterozygous Tbrl mutation
(Tbr1*'~, n=10 of 10 missing posterior limb; Tbr1 /4%, =8
of 8 missing posterior limb; Thr1*"**?%E, 1y =7 of 8 mice missing

posterior limb; Fig. 8A-C). One adult Tbr1™***** mouse showed
a very thinly formed posterior limb (Fig. 8C, arrowhead).
Homozygotes from each Tbrl line showed more severe axon
defects, including misdirected callosal fibers and complete ab-
sence of the AC, as well as aberrant upregulation of NF-M in the
cortex (Fig. 84,B). We also examined the internal capsule, which
contains corticothalamic and thalamocortical axon fibers, and
observed grossly normal organization of this tract in heterozy-
gotes and abnormal organization in homozygotes (Fig. 8D).
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In addition to these defects, we identified ectopic L1-la-
beled axons in the mid-cortex of Thr1™~, Thr1*139/4136F 4nd
Thr [K228E/K228E 5t pg (Fig. 9A). These axons were constrained
to the abnormal inner CUX1™" cortical layer in Thr1™~ mice
(Fig. 9B). Because Tbr1™~ mice lack the subplate layer along
which thalamic axons normally travel to innervate the cortex
(Hevner et al., 2001), we sought to determine whether these
ectopic cortical axons were misguided thalamocortical affer-
ents, or whether they originated intracortically. We placed Dil

crystals in either the thalamus or the cortex of PO brains, and
we observed Dil-labeled cortical axons forming a narrow mid-
cortical tract similar to the L1-labeled ectopic axons (Fig. 9B,
C). Thalamic axons, on the other hand, were misrouted ven-
trally into the external capsule and did not enter the cortex
(Fig. 9D). Altogether, our results show congruent axon defects
across Tbr1®° and patient mutant mouse lines, including a
newly observed intracortical axon defect in homozygous
mutants.
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Tbr1 KO mice, but not patient mutant mice, show extensive
cortical apoptosis

Previous studies of cell survival in Thrl™~ cortex found a sub-
stantial increase in the apoptotic marker CC3 starting by embry-
onic day 16.5 and continuing to PO (Bedogni et al., 2010). To
examine cortical cell survival in Tbr1® and patient mutant
mice, we immunostained for CC3 at P0. WT and heterozygous
mutant mice of each line showed very few CC3™ cells at this
time point (Fig. 10A,B). However, while we saw drastically
increased CC3™ cell density in Thr1”~ cortex, we saw a lim-
ited increase of CC3™ cells in Thr1*?%A13% and no increase
in Thr1*228E/K228E (Tpr1KO. B, o =13.2, p=0.006; Thr1*13°F:
Fo6=17.5, p=0.003; Tbr1***: F, )= 1.18, p=0.350; ANOVA).
Furthermore, CC3™ cells in Thr1™~ cortex spanned multiple corti-
cal areas, while CC3" cells in Tbr1*P¥A13 were restricted to
the piriform area (Fig. 104, arrowhead). When we costained for
CC3 and L5 marker CTIP2 in Tbr1™~ cortex, we found that CC3™
cells were not confined to the CTIP2™ layer, and that 16.8% of the
total CC3™ cells were CTIP2™ (Fig. 10C,D). Thus, homozygosity
of the Tbrl exon 2-3 knock-out allele causes widespread cortical
apoptosis, while patient mutant alleles A136PfsX80 and K228E
have limited impacts on cortical cell survival.

Discussion

In this study, we sought to understand the etiology of TBRI-
related neurodevelopmental conditions via modeling of patient-
specific de novo mutations in mice. Comparing directly with
Tbr1*° mice previously used to study this transcription factor,
we identified a number of shared and distinct phenotypic effects
(Fig. 11A). The de novo frameshift mutant A136PfsX80 (A136fs)
generally phenocopied the KO, suggesting that this mutation is
loss-of-function, while the de novo missense mutant K228E
showed cortical disorganization distinct from KO and A136fs.
One key difference among all three Tbrl mutant lines was the
extent of cortical apoptosis, with homozygous KO causing severe
apoptosis, A136fs limited apoptosis, and K228E normal apopto-
sis. In addition to these discordant phenotypes, we found several

congruent defects across Tbrl lines in olfactory bulb develop-
ment, axon tract formation, and CTIP2 and NF-M levels. These
findings reveal molecular and cellular processes sensitive to TbrI
gene disruption regardless of mutation type, suggesting
core biomarkers or therapeutic targets for TBRI-related
conditions. Furthermore, identification of mutation-spe-
cific effects may lend insight into the phenotypic variability
of these conditions.

Construct validity of Tbr1 mouse models for
neurodevelopmental conditions
Upon the association of TBRI mutations with neurodevelop-
mental conditions, several Tbrl mutant mouse models were
generated to study their underlying biological mechanisms.
Mice with one copy of TbrI disrupted by insertion of a PGK-
neo cassette were used to model human TBRI haploinsuffi-
ciency (Bulfone et al., 1998; Huang et al., 2014). To identify
autism-related functions of Tbrl within cortical neuron sub-
populations, Cre-loxP recombination was used to delete Tbrl
in layer 5 or layer 6 during late embryonic to early postnatal
development (Fazel Darbandi et al., 2018, 2020, 2022). Cre-
loxP was also used to generate mice carrying the K228E
patient mutation before our study (Yook et al., 2019). While
these models have revealed potential molecular and cellular
mechanisms underlying TBRI-related conditions, their con-
struct validity is limited by the retention of genomic artifacts
(i.e., neo cassette, loxP sites) and/or the timing of Tbrl dele-
tion several days after its initial expression. With CRISPR ge-
nome editing, we addressed these potential limitations in our
Tbrl models by incorporating the exact patient mutations into the
mouse genome without the inclusion of additional sequences.
These differences in mouse line generation methods could
explain the phenotypic discrepancies between our CRISPR-gen-
erated Tbrl models and previous models. For example, the
severe cortical apoptosis unique to Thr1”~ mice (Fig. 10) could
potentially result from the production of an aberrant transcript
from the neo cassette, as was previously reported for Menl KO
mice (Scacheri et al.,, 2001; Bedogni et al., 2010). Alternatively,
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the neo cassette could disrupt regulatory elements within the
Tbrl locus for nearby genes, in which case the TbrI KO line
could still serve to model intragenic TBR1 deletions (Olson et al.,
1996; Pham et al,, 1996; Meier et al., 2010; Jin et al., 2021).
Another example of a potential off-target effect is the altered
interneuron distribution seen in previously generated K228E
mutants, which retain an intronic loxP site (Yook et al., 2019).
While this study found a shifted distribution of parvalbumin
interneurons from superficial to deep layers in Thr1™"****F cor-
tex, our CRISPR-generated Thr1*"****¥ mice showed no changes
to the distribution of cortical interneurons (Fig. 7). However,
this discrepancy could also arise from differences in cortical area
examined, as the prior study analyzed medial prefrontal cortex
while we analyzed somatosensory cortex.

Despite the potential limitations of previously generated Tbrl
mouse models, they can recapitulate features of human TBRI-
related conditions. Namely, in the study by Huang et al. (2014),
TbrI™"~ mice showed reduction of the AC, a phenotype later
observed in seven of seven individuals of a TBRI patient cohort
examined by MRI (Nambot et al., 2020). Analysis of Thrl™"~
mice found an absence of the posterior limb of the AC using
histologic stains, and axon labeling approaches showed severe
reduction of the interamygdalar axons comprising this structure
(Huang et al., 2014). A follow-up study also found a reduction of
the anterior limb of the AC, which connects the two olfactory
bulbs (Huang et al., 2019). When we immunostained for axon
markers L1 and NF-M, Tbr1 /A5 and Tbr1*"****f mice lacked
an apparent posterior limb, further reinforcing that this brain
structure is highly sensitive to the mutation of one Tbrl copy
(Fig. 8). We speculate that the posterior limb defect in Tbrl
patient mutation mice could also be attributed to diminished
interamygdalar axons, considering their similarity to Tbrl™’~

mice analyzed alongside. Thus, Tbrl mutant mice with inserted
DNA elements can be valid for modeling TBRI deficiency, but
results should be interpreted with caution and, if possible, vali-
dated in multiple TbrI mutant mouse lines.

In addition to our main findings, we observed that the p.
E348_P353del (A6aa) mutation did not alter TBR1 levels (Figs.
2, 3) or cortical layer formation (Fig. 4). This result, combined
with the low conservation of these residues among mouse T-box
proteins (Fig. 1), suggests that substitutions or in-frame deletions
within this region may not substantially impact TBR1 function.
Accordingly, the reported human missense variants T350A,
S351R, and P353A may be of low clinical impact as predicted by
PolyPhen and SIFT analyses (Extended Data Fig. 1-1; Landrum
et al., 2018; Karczewski et al.,, 2020). In contrast, the nonsense
mutations S351X and Q352X show higher pathogenicity predic-
tions, and the S351X protein was verified to be dysfunctional in
vitro (Deriziotis et al., 2014). While TBR1-A6aa functionality is
sufficient for corticogenesis, we cannot rule out subtler effects of
this deletion on cortical development or neuronal function.

Potential Tbr1 autoregulation in early postnatal cortex

Our analyses of Tbrl transcript and TBRI protein levels provide
insights into the regulation of this gene in early postnatal cortex
(Fig. 11B). In PO Thr1%© and Thr1*"*%* mutants, transcript
changes did not mirror protein changes: heterozygotes showed a
25-30% reduction in TBRI1 protein but <8% reduction in Tbrl
transcript, while homozygotes showed nearly 100% reduction in
protein but only 25-60% reduction in transcript (Fig. 2). Based on
these results, we speculate that TBR1 negatively autoregulates its
expression in postnatal cortex, as transcription factors commonly
perform autoregulatory functions to ensure proper abundance
in cells (Crews and Pearson, 2009). Supporting this possibility,
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TBR1-bound sites near the Tbrl gene (i.e., potential autoregulatory
elements) have been previously identified using ChIP (chromatin
immunoprecipitation)-sequencing (seq) assays in developing mouse
cortex (Notwell et al., 2016; Fazel Darbandi et al,, 2018). In Tbr1%°
and Tbr1*"%* mutants, transcripts from the mutant allele may
undergo nonsense-mediated decay or other mRNA degradation
processes, as suggested by the low A136fs transcript levels in Figure
2H, leading to reduced TBRI1 protein levels and reduced negative
autoregulation. In Tbr1"**** mutants, the K228 mutation likely
inhibits TBR1 binding to DNA, also leading to reduced negative
autoregulation and increased Tbr1 transcript/protein levels (Yook et
al,, 2019). The overabundance of TBRI protein in these mice may
also result from increased stability of the K228E protein (den Hoed
et al,, 2018; Yook et al., 2019).

Failure of negative autoregulation could also contribute to the
unexpected ectopic TBR1 in nearly all cortical neurons of
Thr1X228E/K228E e (Fig. 3). It has been postulated that the acti-
vation of TBR1 is an obligatory step in the differentiation of cort-
ical radial glia into postmitotic neurons (Englund et al., 2005).
Supporting this, single-cell RNA-seq of mouse corticogenesis
found that cells born during the neurogenic period (embry-
onic days 12-15) highly express Tbrl on differentiation (http://
genebrowser.unige.ch/telagirdon/; Telley et al., 2019). Newborn
neurons then either maintain or repress Tbrl depending on their
subtype specification: Tbrl is maintained in L6 corticothalamic
neurons, while in other neuronal subtypes TbrI is repressed by
transcription factors including BCL11A (CTIP1) and FOXGI1
(Toma et al., 2014; Cénovas et al., 2015; Liu et al., 2022). In non-
corticothalamic neurons, negative autoregulation by TBR1 could
perhaps then serve to inactivate its own expression through
direct binding with its repressor BCL11A (den Hoed et al., 2018).
Exploration of this hypothesis could lend important insights into
TBR1-dependent regulatory networks and neuronal fate specifi-
cation in the developing cortex.

Future directions

Future studies using patient-specific Tbrl mutant mice to model
human conditions should focus on construct validity for underlying
mechanisms, face validity for symptoms, and predictive validity for
therapeutics. Molecular profiles and physiological properties of neu-
rons should be compared across Tbr1 mouse lines to identify shared
etiologies. In addition, behavioral profiles should be characterized
for comparison to TBRI-related conditions, particularly for anxiety,
aggression, epilepsy, and other debilitating symptoms (Nambot et
al,, 2020). Testing therapeutics for such symptoms in Tbrl patient
mutant mice could greatly benefit patients with TBRI-related or
other neurodevelopmental conditions. Finally, beyond these transla-
tional directions, studying Tbrl patient mutant mice can inform
our basic understanding of corticogenesis. We identified mutation-
specific cortical layering defects, which hint at differential impacts
on TBRI"/Reelin” Cajal-Retzius cells during early cortical devel-
opment (Fig. 4; Hevner et al., 2001). Furthermore, we identified ec-
topic intracortical axons in Tbrl mutants, but whether this defect
arises cell autonomously from TbrI-deficient projection neurons or
is secondary to cortical disorganization in these mice remains
unclear (Fig. 9). Future studies examining TBR1 functions in differ-
ent cortical neuron subtypes can shed light on these fundamental
neurodevelopmental processes.
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